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1. INSTALLATION	INSTRUCTIONS	FOR	CANDE‐2015		
 

Purpose.  

The purpose of this instruction is to install the new CANDE-2015 DLL (dynamic link file) 
named “cande_dll.dll” into the CANDE executable folder containing the CANDE-2007 program 
with the 2011 upgrade. The new DLL, which replaces the old DLL with the same name, contains 
new executable logic for all enhancements to CANDE since 7/31/2011, which is the last 
TRB/NCHRP release date. 

 
Instructions to install new DLL 
 

1. Locate the CANDE executable folder currently in your computer, usually stored in the 
directory Program Files, or Program Files (x86). The default folder name is “CANDE 
2007” even though it contains the 2011 upgrade. 
  

2. Right click the new DLL, “cande_dll.dll” accompanying this instruction and obtain a 
copy.  

 
3. Open the executable folder “CANDE 2007” and paste the new DLL into the file. Answer 

yes to the question “Do you wish to replace old “cande_dll.dll” with new? 
 

4. That’s it!  -- You’re ready to go. 
 
 
Verification 

After you run any CANDE input file, you may verify that you are using the new executable 
program by observing that the first line of output says;  

 *** WELCOME TO CANDE-2015(version 3/5/2015) *** 

(Note, the previous version 1/30/2015 has been replaced with the above 3/5/2015 version, with 
greatly improved convergence algorithms for Mohr-Coulomb and Modified Duncan/Selig soil 
models.) 

Peace of Mind 

Do not worry!  You can easily recover the old CANDE program by re-visiting the TRB website 
and downloading CANDE 2007 with the 2011 upgrade. Or you save the previous CANDE-2013 
DLL prior to replacing it with the CANDE-2015 DLL. 



2. WHAT	IS	CANDE‐ 2015 
 
CANDE-2015 is the latest in the series of CANDE computer programs, which date back to 1976, and is 
dedicated to the structural design and analysis of buried culverts. The 2015 version of CANDE is an 
extension of the AASTO/TRB version CANDE-2007/2011 with seven new capabilities listed below. 

1. CONRIB pipe type.  This is a new pipe type in CANDE-2015 with modeling capabilities for rib-
shaped reinforced/concrete cross-sections. Also, the concrete stress-strain model has the ability to 
model fiber reinforced concrete. (Industry sponsor Con/Span Bridge Systems) 

2. CONTUBE pipe type.  This is another new pipe type added to the pipe library that permits 
modeling circular-shaped concrete cross sections encased in fiber-reinforced plastic tubes spaced 
at uniform distances. (Industry sponsor Advanced Infrastructure Technologies) 

3. Link elements with death option. Links are useful for connecting one beam-element group to 
another in either a pinned connection or fixed-moment connection. Also, the link element offers a 
death option that allows simulating strut removal, culvert erosion, and creation of soil voids. 
(Industry sponsors Contech Construction Products and MGK Consulting) 

4. Deeply corrugated steel structures.   CANDE’s corrugated steel pipe type now includes the 
new AASHTO combined moment-thrust design criterion and new global buckling equation for 
deeply corrugated steel structures. Also, the plastic-penetration algorithm has been improved. 
(Industry sponsors Atlantic Industries and Contech Construction Products) 

5. Variable plastic profile properties. The input data defining plastic profile section properties has 
been expanded to allow variable profile geometry around the pipe’s periphery. This is useful for 
arch-shaped storm-water chambers that vary the plastic profile geometry from top to bottom. 
(Industry sponsors Advanced Pipe Services and Prinsco)    

6. Classical Mohr/Coulomb elastic-perfectly plastic model.  This traditional elastoplastic model 
is now included in the suite of available constitutive models that may be assigned to continuum 
elements to describe soil behavior. (Industry sponsors Contech Engineered Solutions and MGK 
Consulting) 

7. Modified Duncan/Selig soil model.  A modified version of the Duncan/Selig model is now 
available, which produces permanent deformations upon unloading similar to advanced plasticity 
models. No new material parameters are introduced into the new formulation; thus, the existing 
data base of Duncan/Selig parameters remains valid for the modified formulation. (Industry 
sponsors Contech Engineered Solutions and MGK Consulting) 

Q & A 

Who sponsored the new capabilities?  New capabilities and improvements in CANDE-2015 are provided 
gratis as a result of the industry sponsors noted above. 

Does CANDE-2015 work with all old input files?  YES! All input files that worked with CANDE-
2007/2011 or CANDE-2013 will work the same way with CANDE-2015. 

How do I use the new capabilities?  The CANDE-2015 User Manual provides complete batch-mode 
input instructions for the new capabilities written in red ink. The GUI input menu is not updated for the 
new capabilities -- see the discussion at the end of this document for working with the GUI. 



3. NEW CAPABILITIES 2015 AND REFERENCES	
 

Description of  new capabilities in CANDE-2015 

User Manual 
Chapter 5, 
Section number and  
(line marker) 

Solution and 
Formulation 
Manual, 
Section No. 

CONRIB pipe type.  CONRIB has been added to CANDE’s 
pipe-type library that provides the capability of modeling rib-
shaped reinforced/concrete cross-sections as well as standard 
rectangular cross sections. Moreover, the concrete constitutive 
model has been extended to include the simulation of fiber 
reinforced concrete.  (2013) 

 
5.3.2  (A-2) 

and 
5.4.5 (B-1 to B-6) 

 
 

2.6 

CONTUBE pipe type.  This special pipe type provides the 
capability of modeling circular shaped concrete cross sections 
encased in fiber-reinforced plastic (FRP) tubes spaced at 
uniform distances.  (2013) 

 
5.3.2 (A-2) 

and 
5.4.6  (B-1 to B-6) 

 
 

2.7 

Link elements with death option. Two simple options are, (1) 
connect any two nodes with a pinned connection; or, (2) connect 
two beam nodes with a fixed-moment connection.  The link-
element death option is an extremely useful capability allowing 
the removal of any link element and its forces at any specified 
load step.  Also a special composite joining option for beam 
groups. (2013) 

 
5.5.6.4  (C-4) 

and if composite 
5.6.8  (D-2) 

 
 

4.11 to 4.15 

Deeply corrugated steel structures. Updated steel pipe type to 
accommodate the recently adopted AASHTO requirement for a 
combined moment-thrust design criterion that applies to deeply 
corrugated steel structures as well a new AASHTO equation to 
predict the global buckling resistance. These new design criteria 
may be activated at the user’s discretion. (2013) 

 
5.5.4.1  (B-1) 

and 
5.5.42 (B-2) 

 
 

2.2.2 
 

Plastic pipe type variable profile properties. The plastic pipe 
subroutine has been revised to allow variable profile geometries 
around the structure. This applies to all types of plastic including 
HDPE, PVC, and PP.  Useful for analyzing storm-water 
chambers. (2013) 

 
5.4.3.4 (B-3, B3b) 

 

 
 

2.4.3 

Mohr/Coulomb plasticity model. The classical Mohr/Coulomb 
elastic-perfectly plastic model is now included in the suite of 
available constitutive models that may be assigned to continuum 
elements to describe soil behavior. Four material parameters are 
required to define the model: E, ν, c and φ.  (2015) 

 
 

5.6.9 (D-2) 

 
 

3.7 
(3.8) 

Modified Duncan/Selig soil model. The new modified 
Duncan/Selig model produces permanent deformations upon 
unloading similar to advanced plasticity models. No new 
material parameters are introduced into the new formulation; 
thus, the existing data base of Duncan/Selig parameters remains 
valid for the modified formulation. The user has the option to 
use either the Original or Modified version.(2015) 

 
 

5.6.4.1 (D-2) 

 
 

3.58 to 3.59 
(3.8) 

 

 



4. USING	THE	GUI	WITH	CANDE‐2015	
 

The graphical user interface (GUI) works with CANDE-2015 in exactly the same manner as it 
works with the original CANDE-2007/2011 program except for utilizing the new capabilities 
developed after 2007. When dealing with any of the following new capabilities; 

 CONRIB Pipe Type  
 CONTUBE Pipe Type  
 Link   elements  
 Deep corrugation design criteria for Steel Pipe Type  
 Variable Profile geometry for Plastic Pipe Type 
 Mohr-Coulomb elastoplastic soil model 
 Modified Duncan/Selig model with plastic-like behavior 

 
it must be understood that the GUI input wizard is unaware of these options. Consequently to 
utilize these new capabilities, the input data must be entered in the batch-mode. That is, from the 
File menu on the CANDE screen select “Open text input” and refer directly to the input 
instructions in Chapter 5 of the CANDE-2015 User Manual to enter the required data.  
 
The GUI has two facets, pre-processing and post processing. Pre-processing is concerned with 
creating input data files, and post-processing deals with viewing the output files and graphically 
plotting the finite element mesh and structural responses. Both facets are discussed below with 
regard to how they interact with the new capabilities listed above. 
 
Creating Input Files (pre-processing). The GUI interface menu offers two basic modes for 
creating an input data file as listed below. 

1. Traditional batch input (choose File → Open Text Input) 
2. Menu-driven input (choose File → New) 

 
Mixing these two input methods is the easiest way to generate an input file that incorporates any 
of the new capabilities. For example, suppose we want to create an input file utilizing the 
CONRIB pipe type. The Menu-driven input screen does not have a selection choice for the 
CONRIB pipe type; however, we can choose the CONCRETE pipe type as a temporary 
surrogate. After all the remaining menu-driven input data is complete and the entire data file has 
been saved and stored, we reopen the data file with “Open Text Input” and refer to CONRIB 
pipe type in Chapter 5 of the CANDE-2015 user manual to replace the input lines of the 
surrogate pipe data with the required CONRIB input data. Said another way, this second step is a 
mini-batch-mode input process, only changing a few lines of input. The above process also 
applies to CONTUBE. Note that the GUI-generated line tags ending with double exclamation 
marks for the surrogate CONCRETE pipe type, such as B-1.Concrete!!, can be removed so that 
CONRIB or CONTUBE input data begins in column 1 in accordance with the CANDE-2015 
User Manual. 
 
As another example, consider creating a Level 3 input file incorporating link elements. From the 
element input instructions in Chapter 5 (C-3 lines), we observe that the link element nodal 



connectivity is defined exactly like an interface element so that we may use the interface element 
as a surrogate to enter nodal connectivity in the Menu-driven screens. Later when we switch to 
Open Text Input, the special link element connection code and death option may be typed in the 
specified columns.  
 
Menu-driven input for the Modified Duncan and Duncan/Selig soil models is straight forward 
because no surrogate name is needed. We simply select the original Duncan/Selig model (ITYP 
= 3) and supply data in the usual manner whether it be canned soil parameters like SW90 or 
USER defined parameters. Next we switch to Open Text Input and insert one new data entry, 
NEWDS = 1, as described on line D-2 of the Duncan and Duncan/Selig input data in the 
CANDE-2015 User Manual. If this new data item is not entered the Original formulation is 
employed.   
 
Finally for the new Mohr-Coulomb elastoplastic model (ITYP = 8), the linear elastic soil model 
(ITYP = 1) may be used as a surrogate in the Menu-driven input screen. After switching to the 
batch input mode, we remove the GUI-generated line tags for the surrogate soil model and enter 
the Mohr-Coulomb data following the directions for lines D-1 and D-2 in the user manual. 
 
In summary, this two-step process of generating menu-driven input data followed by a mini-
batch-mode correction is a very effective way of creating input files for all the new capabilities. 
 
Viewing Output Files (post-processing).  After a successful CANDE run, the View tab on the 
GUI tool bar includes the viewing options listed below. 

 Output Report (CANDE) 
 Mesh Plot 
 Graphs 

 
As discussed next, these viewing options have different implications with regard to displaying 
the output from the new capabilities.  
 
Output report (CANDE). The Output Report, which is the most important document, is a 
complete print file generated by the CANDE-2015 program and is navigable by means of an 
interactive table of contents. Since the table of contents and the printed output is generated 
directly from the CANDE-2015 Engine, there is no loss of data or ambiguity with regard to the 
new capabilities. For example, the table of contents identifies these capabilities by name, such as 
“CONRIB”, CONTUBE” and “Link”, just as it does with all other pipe types and element types. 
Similarly, the output identifies the Mohr-Coulomb model and parameters by name as well as 
which version of the Duncan/Selig soil model is employed, Original or Modified. Therefore the 
new capabilities are displayed perfectly and seamlessly with regard to viewing the Output 
Report. 
 
Mesh plots. The GUI mesh plot viewing option, which allows plotting finite element mesh 
topology as well as displacements, and soil stress/strain contours, is fed by a XML plot file 
developed especially for the GUI. Consequently, the words “CONRIB” “CONTUBE” or “Link” 
do not appear in the input or output screens for selecting data to be plotted. Instead the generated 
XML plot files have been assigned alias names as follows; 



 Each CONRIB pipe-type group number is labeled as a CONCRETE group number. 
 Each CONTUBE pipe-type group number is labeled as a CONCRETE group number. 
 Each “link” element is labeled as an “interface” element with its unique element number. 

 
When mesh elements using the Mohr-Coulomb soil model are “clicked” on screen, the soil 
model name is shown as “Hardin”, which is a surrogate name borrowed from an old legacy soil 
model still available in CANDE-2015. However, the actual soil model is easily verified by 
checking the element’s material number with the soil model information printed in the output 
report. Similarly, if the element’s soil model is identified as Duncan or Duncan/Selig, the 
distinction between the original and modified formulation is easily verified by checking the 
element’s material number with the soil model information printed in the output report. 
 
With the above understanding, the new pipe types, link elements, and soil models have full 
access to the GUI plotting capabilities. If there is more than one pipe group, the user identifies 
the pipe type by its unique group number. Similarly the user identifies link elements (versus 
interface elements) by the unique element number, and soil models with unique material 
numbers. 
 
Graphs. The GUI graph plotting option is dedicated to viewing structural responses of any pipe-
type group wherein the plot data is obtained from another XML plot file developed for the GUI. 
Using the same alias names noted above, each CONRIB and CONTUBE pipe-type group 
number is labeled as a CONCRETE group number. Therefore, using the CONCRETE label with 
unique pipe group numbers, the CONRIB and CONTUBE structural responses may be plotted 
just like any other pipe type. (Hint -- If the “Graph” option does not seem to work, rerun the 
input file under then “Open” option instead of the “Open Text Input” option.) 
 
 
 


